


WordSearch Deluxe is a must have for 

teachers, newsletter editors and puzzle 

enthusiasts. Improve your vocabulary in 

any subject, or just have fun! 
e Create hidden word puzzles, just like 

the ones you've seen in newspapers, 

magazines and schools. Type in a list of 
words or import them from a word 

processor (sorted and spell-checked)! 
WordSearch Deluxe hides them in the 

directions You choose, in a maze of 

random alphabetic characters. 

e On screen or on paper. Solve the © 

euzzle on the screen or print it out on © 

paper and use a pencil. Either way 
they're Fun to create and fun to play! 

The key can also be printed. 

© Add art and color. With WordSearch 

Deluxe and the draw or paint program of 

your choice, you can embellish your 

brain-teaser with clip_art or with your 

own designs in color-or black and white. 
Your imagination is the limit! 
e Cut and paste digitized sounds! 
Instructions show you hew to cut and 

paste digitized sounds already in your © 

system. Use the sound recording 
program of your choice to create new 
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sounds to use as fanfare when a word is 

found or when the puzzle is solved. 
e Flexible layout. Change the size, | 

shape and position of the puzzle at any : 

time to suit your whim. 

e Publish! Export your puzzle from 

WordSearch Deluxe into the page layout 

program of your choice for publication! 

WordSearch Deluxe will work with any 

page layout program that can import a 

PICT File. 

We're sure that you'll enjoy making and 

solving an endless variety of word 

puzzles using this program and your OWN 

imagination. Happy searchino! 

Fun for all ages. 
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Thanks for purchasing WordSearch Deluxe. We're 

sure you'll enjoy making and solving an endless variety 

of word puzzles using this program and your own imagi- 

nation. To be informed of other entertaining titles in the 

MackKids line of educational software, be sure to fill out 

and return the registration card. 

WordSearch Deluxe allows you to create your own 

hidden-word puzzles, just like the ones you’ve seen in 

newspapers, magazines and schools. Type in or import a 

list of words. WordSearch Deluxe hides them in the di- 

rections you choose, in a maze of random alphabetic 

characters. You can solve the puzzle on the screen, or 

print it out and use a pencil and paper. The key can also 

be printed. 



You can include color and graphics in your puzzles. 

Add your own sounds to be played when the puzzle is 

solved. Change the size and layout of the puzzle to suit 

your needs. 

Export your puzzle from WordSearch Deluxe into 

the page layout program of your choice for publication! 

WordSearch Deluxe will work with any page pave pro- 

gram that can import a PICT file. 

Happy puzzling! 
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About This Document 
This booklet will guide you to an understanding of 

the features of WordSearch Deluxe. These instructions 
assume that you know how to create a folder, how to 

“drag” items and know what an “icon” is. You also need 

to be familiar with standard Macintosh facilities such as 

the control panel device and copy and paste operations. 

If you are unfamiliar with these terms, spend some time 

with your Macintosh manual before going on. 

Installing WordSearch Deluxe 
To install WordSearch Deluxe, create a folder titled 

“WordSearch Deluxe” on your hard drive. Insert the 

WordSearch Deluxe diskette into your floppy drive and 

open the diskette by double-clicking on its icon. Drag 

the WordSearch Deluxe icon to the new folder you creat- 

ed on your hard drive. Drag the Puzzles icon to the new 

folder you created on your hard drive. Eject the dis- 

kette. Store this disk in a safe place. It is your backup 

copy. 

When you are finished, the new folder on your hard 

drive should look like this: 

2 items 

wordSearch Puzzles 

To start WordSearch Deluxe, double-click on the 

WordSearch icon. 

WordSearch | 3 
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Playing a WordSearch Puzzle 

AAAR ARRAN 

WordSearch Deluxe 
by Jim Wrenholt & Kent Porter 

©1991 by Nordic Software, Inc. 

All Rights Reserved. 

see Fnloase, dts NOT ota tor alters? © 

When WordSearch is launched, your initial options 

are to create a new puzzle, open an existing one, get 

help or quit. There are a number of sample puzzles in- 

cluded with WordSearch Deluxe. You can play one of 

these or create your own. Keep in mind that even if you 

have played a puzzle once, it can still be a challenge. 

Each time you open a puzzle it is completely reshuffled. 

You can play the same puzzle over and over without see- 

ing the same solution twice! 

The startup screen presents four choices: New, 

Open, Help and Quit. These same four choices will re- 

turn when a puzzle is finished. To play an existing 

WordSearch puzzle select it from the file list and click 

Open. 

The puzzle is displayed on the screen along with the 

list of words you are to find. At this point you may play 

the puzzle on the screen or you may print it and its solu- 

tion (see Printing a Puzzle further on in this docu- 

ment). 

You may want to change the puzzle in some way. All 

changes are made in layout mode. Choose Layout 

4 i? WordSearch 
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Mode from the WordSearch menu. If the menu bar is 

not visible, hold down the command key and press the 

space bar. This key sequence toggles the menu bar in 

and out of view. The keyboard shortcuts for Open, New, 

Copy, etc. work as expected whether the menu bar is 

displayed or not. 

When all changes have been made, leave layout 

mode by selecting Layout Mode from the Layout 

menu. It is at this time that changes to the puzzle are 

saved. You are asked to confirm that you want to save 

the new layout of the puzzle. If you decline to save the 

layout, the changes made are temporary and will only 

be in effect until you close the puzzle. 

To solve the puzzle, locate a hidden word in the let- 

ter grid — it may be spelled up, down, left, right or diag- 

onally, depending on how many directions you allow 

(see Word Directions further on in this document). 

Once you have located a word, use the mouse to select 

it: place the mouse pointer on either end of the word, 

hold the mouse button down and drag the pointer to the 
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other end of the word and release the mouse button. If 

the word you select in this manner is indeed one of the 

words in the list, it remains circled and a check mark 

appears next to it in the word list. 

~ When you have found all of the words in the list, a 

sound will be played if one has been attached to the puz- 

zle (see Adding Sound further on in this document). 

The circles around the words will flash until you click 

the mouse to go on to something else. When you click 

the mouse the puzzle is disposed of, and the initial four 

choices, New, Open, Help and Quit, are presented again. 

Now you know how to open and solve an existing 

puzzle. To learn about making a new puzzle, see the sec- 

tion Creating a New Puzzle in this booklet. 

WordSearch Deluxe will run with Monochrome and 

16-bit monitors, but not with “Millions” of colors (32 bit 

color). 

Word Directions 
WordSearch lets you con- 

trol how many directions will 

be used when the words are 

hidden. There are eight pos- 

sible directions. Generally, 

the more of them you in- 

clude, the more challenging 

the puzzles will be. 

Word Directions 

To make your preference 

known to | WordSearch, 

choose Word Directions from the WordSearch 

menu. You must be in Layout Mode in order to make 

this selection. The above dialog will appear. Check the 

directions you want to use by clicking inside the boxes. 

6 WordSearch 
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Hints 
WordSearch can give you some help if you get stuck. 

To specify what kind of hints you want, choose Hint 

Options from the WordSearch menu. You must be in 

Layout Mode in order to select Hint Options. 

When No Hints is selected, WordSearch will not 

give you any hints. If One Hint is specified, when you 

hold down a key corresponding | 

to a letter of the alphabet, Hint Options 

WordSearch will show you the O No Hints 

locations of all such charac- @ One Hint 

ters. For example, if you press 

the ‘A’ key, all of the A’s in the 

puzzle will be highlighted. If 

Two Hints is chosen, then you 

can hold down two keys to find 
the locations of any two let- 

ters. Sticky Hints allows you to type any number of 
letters, and as you do they will be highlighted on the 

puzzle and will stay highlighted for the duration of play. 

(>) Two Hints 

© Sticky Hints 

Creating a New Puzzle 
Clicking the New button produces the standard 

Macintosh save dialog in which you specify a name and 

a location for the new puzzle. When you click $ave, you 

are presented with a window in which to type the list of 

words you want hidden in your puzzle. The puzzle is 

saved when it is created, and again (if desired) whenev- 

er you exit the layout mode. 

Type in each word followed by a <Return> until all 

the words in your list have been entered. Click OK, 

voila! The puzzle grid and the word list are displayed. 

At this point you can solve the puzzle, print it or you 



can work with the layout 

options to change _ the 
puzzle’s appearance. You 

can also include a sound to 

be played when the puzzle 

is solved (see Adding 

Sound further on in this 

document). You can choose 

upper or lower case from 

the “layout” mode. This 

option changes both the 

word list and_ puzzle 

display. 
Edit 

Word List | It is possible that the 

cae as words you typed in will not 

all fit in the puzzle box using the current settings for 

box size and puzzle font. If so, WordSearch will alert you 

to the situation. You can use the layout features de- 

scribed later to make appropriate changes. 

Editing a Word List 
After a puzzle has been created, its word list can be 

modified at any time by entering layout mode and se- 

lecting Edit Word List from the WordSearch menu. 

The list is presented in a scrolling text window. You can 

add new words, delete words and correct spelling. Up to 

100 words may be used in a puzzle. When finished, click 

OK. The puzzle is displayed again with the new list. To 

play or print the puzzle you must leave layout mode. If 

you change the layout of a puzzle after having partially 

solved it, the puzzle restarts from scratch when yeu 

leave layout mode. 



Printing a Puzzle 
To print a puzzle and its solution, open the puzzle in 

WordSearch and select Print Puzzle from the File 

menu. To print the puzzle solution select Print Solu- 

tion from the File menu. Note: Since the puzzle is com- 

pletely rebuilt when certain layout elements are 

changed, be sure to print a solution for a puzzle before 

making any layout changes to a printed puzzle (if the so- 

lution is desired). The name of the file appears centered 

at the top of the page when printing directly from Word- 

Search Deluxe. 

Alternatively, you can print from the Finder, with- 

out explicitly opening WordSearch. Select the Word- 

Search puzzle file(s) you want and then select Print 

from the Finder’s File menu. This second method will 

present two print job dialogs for every puzzle selected: 

the first of the two is for the puzzle, the second one is for 

the solution. When printing from the Finder, if you do 

not want the solutions printed, simply cancel the second 

_ print job dialog. 

With most high resolution printers (LaserWriter, 

StyleWriter, etc.) it is possible to print puzzles which 

are larger than the on-screen-work area by creating a 

puzzle with a small font and printing an enlarged copy. 

The degree of enlargement is controlled in Page Setup. 

. Adding Sound 
If you are familiar with any program which allows 

you to create and edit sounds, you can easily add any 

sound you like to a WordSearch puzzle. If you use a 

Macintosh LC or a IIsi you can use the built-in sound re- 

corder in the control panel to create your own sounds. 

The sound is played either when a word is found or 

when the entire puzzle is solved, depending on how you 
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assign it. You can paste two different sounds into your 

puzzle; one to be played when a word is found and an- - 

other to be played when the puzzle is solved. 

~Play this sound when... 

@) a word is found 

© puzzle is solved 

- Once you have found a sound you want to use as fan- 

fare, simply Copy it from within a program having that 

capability. (One such program is SoundEdit™ from Fa- 

rallon Computing, Inc.) Then go into WordSearch De- 

luxe, open a puzzle, and enter layout mode by selecting 

Layout Mode from the WordSearch menu. Next, se- 
lect Paste Sound from the WordSearch menu. The 

sound will play with dialog to follow. 

Finally, leave layout mode by once again selecting 

Layout Mode from the WordSearch menu. When 
asked if you wish to save the layout, say yes. The sound 

will then be heard upon the event to which it was as- 

signed. 

As a quick demonstration of this feature you can 

open the control panel and go to the sound controls. 

Highlight one of the “system beep” sounds such as “Bo- 

ing” or “Monkey” and select Copy from the Edit menu. 
Then go to WordSearch Deluxe, open a puzzle and paste 

the sound as described above. You will hear the chosen 

sound when a word is found or the puzzle is solved. 

WordSearch 



Colorizing and Adding Graphics 
You can add color to your WordSearch puzzle if you 

have a color paint program. In your color paint program, 

you can create a field of background color the same size 

as the WordSearch window and copy it to the clipboard 

WordSearch allows you to add graphics to your puz- 

zle. Cut and paste a graphic from a clip art collection or 

draw your own with a paint or draw program. Any PICT 

graphic can be copied to the Macintosh clipboard and 

subsequently pasted onto your puzzle and positioned to 

your liking. 

To get a graphic onto the Macintosh clipboard, open 

an application which allows you to view and edit a pic- 

ture. MacDraw and Hypercard are two such programs. 

There are many others. 

Select the graphic you wish to include in your puz- 

zle. Generally, this is done by enclosing a portion of the 

picture within a selection rectangle and choosing Copy 

from the Edit menu. After selecting the desired graph- 

ic, Quit the drawing application. 

Word Search 

“Layout Mode 
acnerecesoreocesvecnsessesvaccosenecsaeenecsssceencnnsonsaerscnverorseanesoosonenees 

Edit Word List 3T 

List Display 

Word Directions 

Hint Options 

Puzzle Font 

List Font 981 

Lower Case 

Paste Picture 

Paste Sound 

Copy List Pick 

Canu Freme Pict 

Start WordSearch and _ select 

Layout Mode from the Word- 
Search menu. Select Paste from 

the Edit menu. You will notice the 

appearance of a rectangle contain- 

ing the graphic you _ previously 

copied. You may now drag the 

graphic to the desired position. You 

may leave Layout Mode by selecting 

the Layout Mode item again or you 

may continue to make _ other 

changes. 

When creating graphics for your 

WordSearch puzzle you may wish 
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you had a size guide to go by so that the dimensions of 

your design are consistent with the size of the window. 

No problem. Start by opening WordSearch Deluxe, 

choose to do a new puzzle and select Copy Frame Pict 
from the WordSearch menu (not in Layout Mode). This 

puts a copy of the WordSearch window rectangle on the 

Macintosh clipboard, which can then be pasted into your 

draw or paint program to serve as a boundary on your 

design. 

Changing Fonts 
At some time you will probably want to use a differ- 

ent font (type style) or size to add pizzazz to a puzzle or 

to fit more letters into a smaller area. 3 

Change the fonts on either the puzzle or the word 

list. Enter the Layout 

Mode (Choose Layout [gen fences © 9 Point 
Mode from the Word- [0% — fees ee 
Search menu). Select iy he pc 

Puzzle Font or List | osnesu 024 Point 

Font from the Word- | 5... — 

Search menu. Ota a en cen eee 

choices present this font | sample 
selection dialog box: 

As you make changes to the settings, the effect of 

those changes are reflected in the sample in the lower 
left hand corner of the dialog box. Simply choose the 

font, size and style you like, and click OK. 

Changing the Layout 
Both the word list and the puzzle box can be resized 

and moved about on the screen. This allows you to 

create puzzles of various sizes and to make room for 

graphics. Changes must be made while in Layout Mode. 

12 WordSearch 
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To change the position of either rectangle, use the 

mouse and drag from the center of the rectangle. Resize 

by dragging the lower right corner of either rectangle. It 

is possible to set the size of the puzzle so small that not 

all the words in the list can be hidden. For smaller puz- 

zles you may want to use a smaller type size (see 

Changing Fonts). The word list will only display 

those words which were successfully stashed. Each time 

you alter the size or position of the puzzle, it is com- 

pletely reshuffled and redrawn with the words in new 

positions. The word list is updated to show which words 

are hidden within the current dimensions of the puzzle. 

WordSearch Deluxe gives 

you choices about how the [ 

Word List Display 
word list is presented on the 

screen. You can select a one-, | 

two-, three- or four-column 

stationary list. Or you can | 
choose a single-column scroll- | 
ing window. Make your choice | eProar faigipns 

by entering Layout Mode and | 

selecting Word List Display eee 
from the WordSearch menu. 

© Scrolling List 

© Single Column 

@ Two Columns 

© Three Columns 

Importing a Word List 
A list of words created in any word processing pro- 

sram can be transferred to WordSearch Deluxe to make 

a puzzle. This is accomplished by using the word proces- 

sor to open the document containing the list of words. 

Once open, select the words to be imported to Word- 

Search, and choose Copy from the Edit menu. Then 

quit the word processing application. 

Immediately open WordSearch Deluxe and choose to 

create a new puzzle. When the window appears for you 

to type in your words, select Paste from the Edit menu. 

WordSearch 13 
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Exporting a Puzzle 
Once you have created your WordSearch puzzle you 

may want to send it to a word processor or page layout 

program to include it in a newsletter, for example. Or 

you might want to further enhance its appearance using 

the more sophisticated design tools of a graphics applica- 

tion. 

WordSearch Deluxe will copy the puzzle, the key or 

the list onto the Macintosh clipboard as a PICT graphic 

to be pasted into a document created by another pro- 

gram. 

Keyboard Short Cuts 
The following shortcuts use the Control Key (%) 

and the corresponding letter for quick access: 

File Menu 

d6 N—New...create a new puzzle 

d6 O-—Open...an existing puzzle 

d6 W-—Close...currently displayed puzzle 

¢ P—Print Puzzle 

a Q— Quit 

Edit Menu 

d X—Cut...selected text 

3d C—Copy...selected text \ 

d6 V—Paste...text from clipboard to word list 

WordSearch Menu 

3d T'—Edit Word List 

d6 Y— Puzzle Font...change the puzzle font 

d L-—List Font...change the font list 

14 WordSearch 



Menu Item Summary 
File Menu: 

New 

Open 

Close 

Page Setup 

Print Puzzle 

Print Solution 

Quit 

Create a new WordSearch puzzle. 

Open an existing WordSearch puzzle. 

Stop playing the current puzzle. 

Specify basic printing options. 

Send the current puzzle to the printer. 

Send the puzzle’s solution to the printer. 

Exit the WordSearch program. 

Layout Menu: 

Layout Mode 

Edit Word List 

List Display 

Word Directions 

Hint Options 

Puzzle Font 

List font 

Paste Picture 

Paste Sound 

Copy Puzzle Pict 

Copy Key Pict 

Copy List Pict 

Copy Frame Pict 

Toggles the following layout functions on and off. 

Make changes to the puzzle’s word list. 

Choose a display format for the word list. 

Choose the directions used in hiding the words in the puzzle. 

Choose the kind of hints to be supplied upon request. 

Choose the font used in the puzzle. 

Choose the font used in the list. 

Transfer a copy of a picture from the clipboard to the puzzle 
window. 

Transfer a sound from the clipboard to a puzzle. 

Put a copy of the current puzzle on the clipboard as a PICT. 

Put a copy of the current puzzle’s solution on the clipboard as a 

PICT. 

Put a copy of the word list on the clipboard as a PICT. 

Put a copy of the game window’s rectangle on the clipboard. Use 

this feature to put a frame of reference into a paint program when 

designing graphics to go with a puzzle. Make your graphics easily 

fit the window. 

WordSearch 15 



Macintosh"™ is a trademark licensed to Apple Comput- 

er, Inc. Apple is a trademark of Apple Computer, Inc. 

Mackids is a trademark of Nordic Software, Inc. 

Warranty and Disclaimer 

Nordic Software warrants the disk to be free of defects 

for ninety (90) days from the purchase date. If the disk 

is found to be defective in this ninety (90) day period, 

return it to Nordic Software for a free replacement. Be 

sure to make a backup copy of your disk for archival 

storage. 

THE SYSTEM AND FINDER ARE COPYRIGHTED 

PROGRAMS OF APPLE COMPUTER, INC. LICENSED 

TO NORDIC SOFTWARE, INC. TO DISTRIBUTE FOR 

USE ONLY IN COMBINATION WITH BODYWORKS. 

APPLE COMPUTER MAKES NO WARRANTIES, 

EITHER EXPRESS OR IMPLIED, REGARDING THE 

ENCLOSED COMPUTER SOFTWARE PACKAGE, ITS 

MERCHANTABILITY OR ITS FITNESS FOR ANY 

PARTICULAR PURPOSE. THE EXCLUSION OF 

IMPLIED WARRANTIES IS NOT PERMITTED IN 

SOME STATES. THE ABOVE EXCLUSION MAY 

APPLY TO YOU. THIS WARRANTY PROVIDES YOU 
WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE 

OTHER RIGHTS THAT YOU MAY HAVE WHICH 

VARY FROM STATE TO STATE. 

Copyright 1991 by 

Nordic Software, Inc. 
P.O. Box 6007 

Lincoln, NE 68506-0007 — 

402-488-5086 

ISBN 0-940081-06-7 Revised 06-93 
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Language Explorer Teaches Four Languages 
REQUIREMENTS: COLOR MAc * 1 MB RAM «¢ HARD DRIVE ° SYSTEM 6.0.7 (WITH 32-BIT QUICKDRAW) OR LATER 

Learn over 500 vocabulary words in English, French, German and Spanish — all in 
one program! Simply select a topic and a language, then place picture tiles in the correct 

frames. Five skill levels offer a challenge for any age. Students will learn common, use- 

ful words in 42 topics. Each topic consists of 12 words. The CD-ROM version 

brings each language alive as you hear each word pronounced by a native 

speaker. You can even choose to hear voices by a female, male or both. Menus 

and online help display in each language. Language Explorer is especially useful 

for English as a Second Language students. Grades K to 12. CD-ROM version 

requires a CD-ROM drive. : 

CD-ROM 

Includes 



Math Solutions for Grades K 
REQUIREMENTS: MAC PLUS OR GREATER * 1 MB RAM ® HARD DRIVE * SYSTEM 6.0.7 OR LATER 

Count Coins with Coin Critters” 

Rev Up Math with Turbo Math Facts” 
. Realistic sound and 

You have $100,395. Would you like to buy this car? 

Price: $64,765 

Horsepower: 183 

Race Cars For Sale 

0-60 mph in 10 seconds 

Top Speed: 256 mph 

with colorful animation and 

fun sounds. Student lessons include identifying U.S. 

coins, purchasing and counting back change, 

among others. 

clearly by a human voice. Correct an- 

swers earn tokens to play a fun, reward- 

ing game. The student’s player file saves 

lessons and game tokens, ready for 

the next Coin Critters session. 

and player 

progress reports for each student. 

displays coin 

values and equivalents. The school | °° 

version includes an illustrated 

g Lessons 

oin eG 

rive excitement into practicing 

5 Coins 
Progress for 

Click heads u 
Pennies -- \ 
Nickels -- Yt 

Dimes -- Ye 

Quarters -- | 
Half Dollars 

Make change 
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animation combine to compel students to practice addition, subtrac- 

tion, multiplication and division. Students earn money for each cor- 

rect answer, purchase the fastest cars affordable, and gear 

up for a race against Turbo Tom. The faster cars cost 

more money, encouraging students to complete more 

problems. From single digit addition to long division, 

let you customize lessons for the indi- 

vidual needs of students. You can set student 

drills for a single lesson or a combination of 

lessons. Incorrect answers work through the 

correct solution onsreen. Turbo Math Facts 

includes such as a step-by- 

step sample of each type of problem. 

To qualify for the 30% discount, Nordic Software must receive a written 

copy of your school purchase order. (Discount doesn’t apply to shipping charges.) If you call in your order, you can fax the purchase 

order. Business hours: 9:00 AM to 5:00 pm cst. Be sure to address or fax your purchase order to Nordic Software for this incredible offer. 
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Clock Shop’ Tells All About Time 

Analog from Digital 

Report” 
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COINS Adjust the hands until they 
match the digital clock and 
click done. 

Also Available: 

WordSearch Deluxe” 
lve and create hidden word puzzles. 

srades K to 12. 

‘ungle Quest” 
“onquer basic math in an exciting adventure. 

svades K to 6. 

<olor Klips” 
Iver 60 drawings of original clip art. 

wades K to 12. 

ingle Copy: 1 program copy, | user’s manual. 

chool Version: 2 program copies, | user’s manual 

nd | *teacher’s manual. 

ab Pack: 5 program copies, | user’s manual and | 

teacher’s manual. 
ite License: 3 program copies, 3 user’s manuals 

ind 1 *teacher’s manual. 

*Teacher s manuals are available for Clock Shop and Coin 
Critters only. Additional teachers manuals can be pur- 
chased direct from Nordic for 20” each. 

ather Time and the helping hands teach students how 

. Click and drag the 

hour and minute hands for a realistic 

to read 

understanding of the clock. A human 

voice 

Correct answers earn time for the pendu- 

lum game that requires a good sense of 

timing. and 

game time in the player file. Also g yessons 

and progress 

reports for each student. You can 

even change the lesson leneth and 

number of attempts to fit your les- 

son plan. Clock Shop’s school ver- 

sion includes a 

ks Language Explorer 

SINGLE 
$57.95 

<< Language Explorer CD-ROM ‘°77* 
$57.95 

$57-95 

$4.9: 

$69-% 

$5Q-99 

$774.95 

TITLE 

se ** Coin Critters Gchool Version Available) 

wy **Clock Shop Gchool Version Available) 

Turbo Math Facts 

WordSearch Deluxe 

Jungle Quest 

Kolor Klips 

LAB 

Dol” 

311" 

*2o4"? 

231" 
$1 Q9Q-80 

$9'79 80 

239 

NA 

SITE 
$695 

NA 

5695% 

5695 

$5QQ-40 

$839-40 

gboles 

NA 

“School Version. Coin Critters and Clock Shop School Versions 
include two copies of the program, one user’s manual and one 

teacher’s manual SCHOOL VERSION °7'7-*° 

Shipping & Handling. Shipping within the continental U.S. is 

$5.00 per order. Call for more information about shipments 
to other destinations. 

PHONE 402-488-5086 Fax 402-488-2914 
Nordic Software ¢ P.O. Box 6007 ¢ Lincoln, NE 68506-0007 

Offer ends September 1, 1994. 

Nordic Software, Inc. 03/94 
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Educational Titles for the Macintosh. 


